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SUMMARY: 35 

A comprehensive laboratory protocol and analysis workflow are described for a rapid, cost-36 

effective, and straightforward colorimetric cell-based assay to detect neutralizing elements 37 

against AAV6. 38 

 39 

ABSTRACT: 40 

Recombinant adeno-associated viruses (rAAV) have proven to be a safe and successful vector for 41 

transferring genetic material to treat various health conditions in both the laboratory and the 42 

clinic. However, pre-existing neutralizing antibodies (NAbs) against AAV capsids pose an ongoing 43 

challenge for the successful administration of gene therapies in both large animal experimental 44 
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models and human populations. Preliminary screening for host immunity against AAV is 45 

necessary to ensure the efficacy of AAV-based gene therapies as both a research tool and as a 46 

clinically viable therapeutic agent. This protocol describes a colorimetric in vitro assay to detect 47 

neutralizing factors against AAV serotype 6 (AAV6). The assay utilizes the reaction between an 48 

AAV encoding an alkaline phosphatase (AP) reporter gene and its substrate NBT/BCIP, which 49 

generates an insoluble quantifiable purple stain upon combination.  50 

 51 

In this protocol, serum samples are combined with an AAV expressing AP and incubated to permit 52 

potential neutralizing activity to occur. Virus serum mixture is subsequently added to cells to 53 

allow for viral transduction of any AAVs that have not been neutralized. The NBT/BCIP substrate 54 

is added and undergoes a chromogenic reaction, corresponding to viral transduction and 55 

neutralizing activity. The proportion of area colored is quantitated using a free software tool to 56 

generate neutralizing titers. This assay displays a strong positive correlation between coloration 57 

and viral concentration. Assessment of serum samples from sheep before and after 58 

administration of a recombinant AAV6 led to a dramatic increase in neutralizing activity (125 to 59 

>10,000-fold increase). The assay displayed adequate sensitivity to detect neutralizing activity in 60 

>1:32,000 serum dilutions. This assay provides a simple, rapid, and cost-effective method to 61 

detect NAbs against AAVs. 62 

 63 

INTRODUCTION: 64 

Adeno-associated viruses (AAV) are increasingly used as vectors for the delivery of gene therapies 65 

to trial treatments for various health conditions that impact the cardiovascular, pulmonary, 66 

circulatory, ocular, and central nervous systems1-5. The popularity of AAV vectors as a leading 67 

gene therapy platform stems from their positive safety profile, long-term transgene expression, 68 

and wide-ranging tissue-specific tropisms1,6. Successful outcomes in animal studies have paved 69 

the way for over fifty AAV gene therapy clinical trials that have successfully reached their efficacy 70 

endpoints7, as well as the release of the first commercially available AAV gene therapy drug 71 

approved by the US Food and Drug Administration8.  Following initial successes, AAV has 72 

continued to gain traction in the basic and clinical research sectors as a vector of choice and is 73 

currently the only in vivo gene therapy approved for clinical use in the US and Europe9. 74 

Nonetheless, the presence of pre-existing neutralizing antibodies (NAbs) against AAV vector 75 

capsids remains a hindrance to both preclinical research and the efficacy of clinical trials. NAbs 76 

are present in both naïve human and animal populations and inhibit gene transduction following 77 

in vivo administration of an AAV vector1. AAV seropositivity is an exclusion criterion for most gene 78 

therapy trials, and therefore preliminary screening for host immunity is crucial in both the 79 

laboratory and the clinic. Establishing an assay that can detect the presence of NAbs against AAV 80 

is an essential step in the pipeline of any AAV gene therapy-based research project. This report 81 

focuses on AAV6 which has been of interest to researchers due to its efficient and selective 82 

transduction in striated muscle (heart and skeletal muscle)1,10-12. Gene therapy is considered a 83 

promising strategy for targeting the heart because it is difficult to specifically target the heart 84 

without invasive open-heart procedures. 85 

 86 

Neutralizing activity is usually determined using either a cell-based in vitro or in vivo transduction 87 

inhibition assay. In vivo NAb assays usually involve administering serum from a test subject (e.g., 88 
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human or large animal) into mice, followed by an AAV with a reporter gene, followed by testing 89 

for the expression of the reporter gene or corresponding antigen. In vitro assays determine NAb 90 

titers by incubating serum or plasma from a human or large animal in serial dilutions with a 91 

recombinant AAV (rAAV) that expresses a reporter gene. Cells are infected with the serum/virus 92 

mixture, and the extent to which the reporter gene expression is inhibited is assessed compared 93 

with controls. In vitro assays are widely used for NAb screening due to their comparatively lower 94 

cost, rapidity in testing, and greater capacity for standardization and validation13,14 compared 95 

with in vivo assays. In vivo assays are often reported to have greater sensitivity15,16, but the same 96 

claim has been made concerning in vitro assays14,17.  97 

 98 

To date, in vitro NAb assays have mainly used luminescence (luciferase) as the reporter gene to 99 

detect neutralization. Although a light-based method has merit in many contexts, a 100 

colorimetric/chromogenic NAb assay may be advantageous in some circumstances. Colorimetric 101 

assays to assess neutralization have been successfully employed for other viruses such as 102 

influenza and adenovirus18,19. Their attractiveness stems from their simplicity, lower cost, and 103 

the requirement for only everyday laboratory apparatus and tools20. NAb assays that use a 104 

luminescence-based reporter gene require costly substrate kits, a luminometer, and 105 

corresponding software for analysis21. This colorimetric assay has the advantage of only requiring 106 

a light microscope and a very cheap substrate. Reporting of the sensitivity of colorimetric versus 107 

luminescent assays has yielded conflicting results. One study suggested luminescence-based 108 

ELISA assays display greater sensitivity and comparable reproducibility to colorimetric assays22, 109 

while another found colorimetric-based ELISA assays to confer greater sensitivity23. Here, a 110 

detailed protocol for an in vitro NAb assay against AAV that utilizes the chromogenic reaction 111 

between an AAV encoding an alkaline phosphatase (AP) reporter gene and a nitro blue 112 

tetrazolium /5-bromo-4-chloro-3-indolyl phosphate (NBT/BCIP) substrate is provided. This step-113 

by-step protocol was developed based on a previous report that utilized an hPLAP (human 114 

placental alkaline phosphatase) reporter gene (AAV6-hPLAP) to detect neutralizing activity 115 

against AAV24. This assay is cost-effective, time-efficient, easy to set up, and requires minimal 116 

technical skills, laboratory equipment, and reagents. Moreover, the simplicity of this assay gives 117 

it the potential to be optimized for broad applications across different types of cells, tissues, or 118 

viral serotypes.    119 

 120 

PROTOCOL: 121 

All aspects of animal care and experimentation were conducted following Florey Institute of 122 

Neuroscience and Mental Health guidelines and the Australian Code for the Care and Use of 123 

Animals for Scientific Purposes following Reference25. 1.5-3-year-old Merino ewes were used for 124 

the study. A schematic overview of the assay protocol is provided in Figure 1.   125 

 126 

1. Initial preparation 127 

 128 

1.1. For assessment in sheep: collect blood in 8 mL serum separator clot activator tubes (see 129 

Table of Materials), leave the blood sample at room temperature (RT) for 20-30 min, and 130 

subsequently spin down at 2,100 x g for 15 min. The clear supernatant that forms at the top of 131 

the tubes is serum.  132 
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 133 

1.1.1. Aliquot the clear aqueous phase into microcentrifuge tubes and store at -80 °C.  134 

 135 

NOTE: The serum at -80 °C  remains stable for ~5 years. Blood was collected from the carotid vein 136 

using a 16 G needle (tip cut-off) and syringe from conscious animals.  137 

 138 

1.2. Heat inactivate fetal bovine serum (FBS) by placing it in a water bath at 56 °C for 30 min 139 

and swirl intermittently. For precision, place a thermometer in a second bottle containing an 140 

equivalent volume of water and add it to the heat bath at the same time as the FBS bottle. Begin 141 

timing when the thermometer reaches 56 °C. 142 

 143 

1.3. Employ proper aseptic technique and cell culture practice for all subsequent steps 144 

performed in the cell culture hood26,27. Spray 70% ethanol on all objects and the hood before use 145 

and clean with 1% sodium hypochlorite upon completion.  146 

 147 

1.4. Make complete Dulbecco's Modified Eagle Medium (DMEM) by combining high glucose 148 

(4.5 g/L) DMEM (89%) with heat-inactivated FBS (10%) and Penicillin Streptomycin (1%). Combine 149 

and filter using a sterile vacuum filtration system (0.22 μm pore size, polyethersulfone 150 

membrane) (see Table of Materials). Store complete DMEM wrapped in foil at 4 °C. 151 

 152 

1.5. Establish HT1080 cells (see Table of Materials) and passage in a 75 cm2 square flask as 153 

described in Reference28. Create multiple frozen stocks of cells. Do not use cells after 20 passages 154 

as further passaging may influence the assay results. 155 

 156 

2. Day 1 – Plating of cells  157 

 158 

2.1. Passage HT1080 cells when they reach ~80% confluency. 159 

 160 

2.2. Pre-warm complete DMEM (prepared in step 1.4), 0.05% trypsin-EDTA, and 1x 161 

phosphate-buffered saline (PBS) to 37 °C in a water bath. Remove the growth medium from 162 

passaged cells using an aspiration system.  163 

 164 

NOTE: All aspiration in this protocol uses a vacuum system with a tube attached to a sterile 5 mL 165 

serological pipette.  166 

 167 

2.3. Wash the cells in 10 mL of pre-warmed (37 °C) 1x PBS and trypsinize cells for 3-4 min in 4 168 

mL of pre-warmed 0.05% trypsin-EDTA to detach the cells from the flask.  169 

 170 

2.4. Inactivate the trypsin by adding 6 mL of pre-warmed complete DMEM and pipette the 171 

cells into a 50 mL tube. Calculate the number and concentration of viable cells using a 172 

hemocytometer and the trypan blue exclusion method29. 173 

 174 



5 
 

2.5. Dilute the cells to a concentration of 1 x 105 cells/mL in pre-warmed complete DMEM. 175 

Seed 100 μL of cells/well into clear 96-well flat-bottomed plates (1 x 104 cells per well). Incubate 176 

the plate at 37 °C, 5% carbon dioxide (CO2) overnight for 16-22 h.  177 

 178 

3. Day 2 – Infecting the cells 179 

 180 

3.1. Remove plate/s from the incubator and use a light microscope to confirm that cells are 181 

evenly dispersed within the wells and that the confluency is ~50%. If cells are not within a range 182 

of 45%-55% confluency, repeat the 'Day 1' protocol and adjust initial cell concentration 183 

accordingly. 184 

 185 

3.2. Generate serial dilutions of the serum samples of interest in 1.5 mL microcentrifuge tubes 186 

using pre-warmed complete DMEM as the diluent. Table 1 demonstrates the generation of a 187 

dilution cascade for triplicate samples.  188 

 189 

3.2.1. To perform the assay in triplicate, prepare a 7.5 x 106 vector genomes (vg)/μL of working 190 

solution of AAV6-hPLAP (see Table of Materials) by diluting a virus stock solution in 1x PBS.  191 

 192 

3.2.2. Add 66 μL of the 7.5 x 106 vg/μL of virus working solution to each tube containing 264 μL 193 

of serum/media dilution (330 μL of total volume/dilution, see Table 1).  194 

 195 

NOTE: This is a robust assay that does not require perfect culture conditions. However, to 196 

accurately quantitate and ensure each assay run is reliable, it is necessary to include the 197 

following: (1) a no serum control, (2) a no serum or virus control, and (3) a NAb positive control 198 

sample on all plates under the same experimental conditions. The volume described (330 μL) 199 

accounts for triplicate samples +10% of the serum and virus mixture. Performing replicates is 200 

highly recommended for the accurate determination of neutralizing activity.  201 

 202 

3.3. Mix the virus/serum dilutions by pipetting and place the tubes containing the virus/serum 203 

mixtures in an incubator at 37 °C, 5% CO2 for 30 min to allow potential neutralization to occur.  204 

 205 

3.4. Pipette 100 μL of the virus/serum mixture to each well on the 96-well plate containing 1 206 

x 104 cells/well for each dilution.  207 

 208 

NOTE: This will generate a final viral concentration of 15k viruses/cell multiplicity of infection 209 

(MOI) in each well. Table 2 provides an example 96-well sample plate layout for assessing 210 

samples to a 1/512 dilution. 211 

 212 

3.5. Wrap the 96-well plate containing cells, serum, and AAV-hPLAP in foil and place in an 213 

incubator at 37 °C, 5% CO2 overnight for 16-24 h to allow AAV entry into the cells.  214 

 215 

4. Day 3 - Fixing and adding substrate to the cells 216 

 217 
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4.1. Pre-warm an aliquot of 1x PBS to 37 °C (~25 mL/96-well plate). Cool, separate aliquots of 218 

PBS (~25 mL/96-well plate) and double-distilled H2O (DDW, ~25 mL/96-well plate) to 4 °C. 219 

Dissolve a pellet of BCIP/NBT (see Table of Materials) in 10 mL of DDW in a 50 mL conical 220 

centrifuge tube by vortexing (10 mL is enough for 2 x 96 well plates). 221 

 222 

4.2. Aspirate the media from the wells of the 96-well plate using a serological pipette or similar 223 

attached to a suction-based aspiration system or fume hood vacuum. Gently place the tip of the 224 

serological pipette into the well and remove the media taking caution not to disrupt the adhered 225 

cells.   226 

 227 

4.2.1. Add 50 μL of 4% PFA to each well using a pipette. Wrap the plate in foil and leave it at RT 228 

for 10 min to fix the cells. 229 

 230 

CAUTION: Paraformaldehyde (PFA) is a probable carcinogen and is toxic from skin or eye contact 231 

or inhalation. Handle in a fume hood with proper personal protective equipment as well as a 232 

facemask. Make fresh 4% PFA diluted in PBS (~7 mL required per 96-well plate) and allow to cool 233 

to RT. 234 

 235 

4.3. Wash and aspirate the cells with 200 μL of RT 1x PBS. Repeat this step twice.  236 

 237 

NOTE: A multichannel pipette is an efficient option for the pipetting steps. 238 

 239 

4.4. Pipette 200 μL of pre-warmed PBS into each well, wrap the plate in foil and incubate at 240 

65 °C for 90 min to denature endogenous alkaline phosphatase activity30. 241 

 242 

4.5. Aspirate wells and wash cells with 200 μL of cold (4 °C) PBS. Aspirate again, wash in 200 243 

μl of cold DDW, and aspirate again. 244 

 245 

4.6. Pipette 50 μL of the dissolved BCIP/NBT (prepared in step 4.1) into each well. 246 

 247 

4.7. Wrap the plate in foil and incubate at RT for 2-24 h.  248 

 249 

NOTE: Be consistent with incubation time between runs; the time flexibility allows users to 250 

photograph wells either on day 3 or the following day. 251 

 252 

4.8. Using a light microscope camera, take photos of each well using a 4x objective lens, 253 

ensuring the same exposure, white balancing, and light settings are used consistently for all 254 

assays performed. 255 

 256 

4.8.1. Position each well identically and ensure the edges of the well are not visible in the 257 

photos. Save photos in TIF format or similar. 258 

  259 

NOTE: Specific settings will vary between microscopes, but quantitation will be most effective if 260 

the background lighting is high and consistent throughout the wells (Figure 1B).   261 
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 262 

5. Quantitation to determine the neutralizing activity using ImageJ 263 

 264 

5.1. Download and install the freely available software "ImageJ" (see Table of Materials). 265 

 266 

5.2. Open the image to be analyzed in ImageJ by selecting File > Open (Figure 2). 267 

 268 

5.3. If using colored images, convert to grayscale by selecting Image > Type > 8-bit.    269 

 270 

5.4. Click on Image > Adjust > Threshold. Adjust the threshold until all colored areas are 271 

colored in red, but the background is not. Upon adding NBT/BCIP, the colored product will 272 

deposit in the area around the cells expressing hPLAP.  273 

 274 

NOTE: It is recommended to use the same threshold setting for all images captured on the same 275 

plate. 276 

 277 

5.5. Click on Analyze > Set Measurements and tick the Area, Limit to Threshold, Area 278 

Fraction, and Display label checkboxes and click on Ok.  279 

 280 

5.6. To determine the signal reading (percentage of coloration) of a given well, click on 281 

Analyze > Measure. The '% Area' column of the pop-up window displays the signal reading.  282 

 283 

5.7. Perform quantitation for all sample replicates. Exclude any contaminated wells, wells 284 

showing uneven cell distribution, or wells varying in cell density or lighting.  285 

 286 

NOTE: See Supplementary Figure 1 for examples of wells that should be considered for exclusion. 287 

Typically, 3-4 wells may require exclusion from a 96-well plate. Figure 2 provides a visual 288 

representation of the quantitation process using ImageJ. 289 

 290 

6. Determination of Transduction Inhibition (TI50) titer 291 

 292 

6.1. Determine the average readout from replicates (using the steps described in step 5) for 293 

the following: (1) Media-only control (baseline signal reading). (2) Virus + media only control 294 

(maximum signal reading). (3) Virus + serum samples of interest. 295 

 296 

6.2. Calculate the percentage of inhibition using the following formula:                                        297 

100 - [(Test sample signal readout (virus + serum sample of interest) - baseline signal readout 298 

(media only control)) / (maximum signal readout (media and virus only) - baseline signal readout)) 299 

x 100] = % Transduction inhibition13.  300 

 301 

6.3. Calculate the % transduction inhibition from all replicates of each dilution for all samples 302 

using the formula in 6.2. Determine the average transduction inhibition between the technical 303 

replicates for each dilution for all samples and controls. 304 

 305 
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6.4. Calculate the 50% transduction inhibition titer (TI50 titer) of a sample of interest by 306 

determining the lowest dilution of the sample that yields 50% or greater transduction inhibition 307 

of hPLAP activity. e.g., if a 1/8 dilution of a sample has greater than 50% transduction inhibition 308 

based on the calculation performed in 6.2 (and a 1/4 dilution does not), report the TI50 titer as 309 

1/8. 310 

 311 

7. Determination of neutralized AAV particles 312 

 313 

7.1. Calculate the number of neutralized AAV particles per μL of serum for a given sample by 314 

employing the following formula:  315 

((MOI x cell count/well) / (volume of serum / dilution factor of TI50 titer)) / 2  = neutralized AAV 316 

particles / μL of serum9.  317 

 318 

NOTE: Dividing by 2 accounts for the TI50 measuring 50% of neutralized particles. For a sample 319 

that gives a TI50 titer of 1/4 (25% serum, 75% diluent) in which the assay used 80 L of undiluted 320 

serum and an MOI of 15k plated onto 1 x 104 cells, the following calculation would be used: 321 

((15000 x 10000) / (80/4)) / 2 = 3.75x106 neutralized particles / μL of serum. 322 

 323 

REPRESENTATIVE RESULTS: 324 

 325 

Transduction assay to establish the optimal viral dosage for plate coverage  326 

HT1080 cells, a well-established fibrosarcoma cell line, were selected for this assay. A 327 

concentration of 1 x 104 HT1080 cells/well provided ~50% cell confluency in each well of a 96-328 

well plate. To determine the optimal viral concentration for the assay, an rAAV encoding an 329 

hPLAP (human placental alkaline phosphatase) reporter gene (AAV6-hPLAP)31 was added in 330 

triplicate at a range of concentrations of vg containing particles per cell (MOI: 0, 150, 500, 1500, 331 

5000, 15000, 50000 & 150000 (Figure 3A)). An MOI of 15000 (1.5 x 108 vg/well) conferred 36% 332 

plate coloration and was selected as the optimal viral dosage. A positive correlation was observed 333 

between coloration and viral concentrations for all MOI between 0 and 1,50,00 (n = 6, r = 0.995, 334 

P<0.001). This concentration adequately displayed the reporter gene signal above the 335 

background in the presence of high concentrations of NAbs (low plate coloration) while not losing 336 

sensitivity due to color saturation in the absence of NAbs (high coloration, Figure 3B).  337 

 338 

The efficacy of the assay, when exposed to neutralizing elements, was trialed using serial 339 

dilutions of an anti-AAV6 mouse monoclonal antibody (mAb) in triplicate. The standard approach 340 

of using the first dilution to display 50% or more transduction inhibition (TI50) was applied to 341 

determine the neutralizing titer of a given sample (step 6). Assessing log10 dilutions, the anti-342 

AAV6 mAb displayed a TI50 titer of ~10 ng/mL (1 ng total mAb), while a concentration of 500 343 

ng/mL (50 ng total Ab) and above completely inhibited reporter gene expression (Figure 3C).  344 

 345 

Assessment of NAbs against AAV6 in sheep samples 346 

Serum was collected from the carotid vein using a 16 G needle (tip cut-off) and syringe from 347 

conscious naïve healthy adult sheep (1.5-3-year-old Merino ewes) (n = 11) and screened to 348 

determine the TI50 titer using the colorimetric NAb assay. Two-fold serial dilutions ranging from 349 
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a 1/2 to a 1/512 dilution were assessed for each serum sample in duplicate or triplicate. The 1/2 350 

dilution contained a total of 40 μL of serum, which corresponded to a concentration of 1.88 x 106 351 

AAV particles per μL of serum. The degree of AAV neutralization varied within the naïve sample 352 

population, with TI50 titer values ranging from as low as 1/2 (blue line) to as high as 1/80 (green 353 

line, 1.88 x 106 to 7.5 x 107 neutralized AAV particles/μL of serum) (Figure 4A).  354 

 355 

Subsequently, direct cardiac injection (n = 5) of AAV6 was performed at doses ranging between 356 

5 x 1012 and 3 x 1013 vg to naïve sheep. Briefly, sheep were anesthetized as previously described32. 357 

The heart was exposed from the left lateral position. The pericardium was opened, and AAV was 358 

administered via 10-40 ~20 μL injections into the left ventricular myocardium (anterior) in the 359 

region around the second branch of the left anterior descending coronary artery (LAD). The 360 

pericardium, intercostal muscle, subcutaneous tissue, and skin were closed, and the anesthetic 361 

was removed. Serum was collected from all animals before and six to eight weeks after AAV 362 

administration from the pre-cannulated right jugular vein using a 16 G needle cut-off and syringe 363 

(~5 mL serum/animal). The colorimetric NAb assay was employed to determine the change in 364 

NAb titer following AAV6 administration. Post-AAV serum samples were screened in triplicate as 365 

2- to 4-fold serial dilutions ranging from a 1/2 to a 1/32768 dilution. Assay results indicated that 366 

AAV inhibition TI50 titer values before AAV administration ranged from 1/4 to 1/80 (3.75 x 106 to 367 

7.5 x 107 neutralized AAV particles/μL of serum; Figure 4B). Following AAV cardiac injection, a 368 

clear and consistent contrast in the NAb titer was observed compared with pre-AAV serum titers 369 

(Figure 4B, Table 3). The lowest AAV dose (5 x1 012 vg) displayed a 1/2048 TI50 titer (dashed blue 370 

line, 1.92 x 109 neutralized AAV particles/μL serum) and the remainder of the doses (1-3 x 1013 371 

vg) displayed TI50 titers ranging from 1/12000 to >1/32768 (1.13 x1 010 to >3 x 1010 neutralized 372 

AAV particles/μL of serum).  373 

 374 

FIGURES AND TABLE LEGENDS:  375 

 376 

Figure 1: Schematic diagram of NAb assay protocol. (A) Visual representation of the NAb assay 377 

illustrating the primary steps involved in the three-day protocol. Briefly, cells are grown and 378 

plated overnight. The following day, serial dilutions of serum are prepared, incubated with AAV, 379 

and then incubated with the cells overnight. The next day, cells are fixed, washed, incubated, 380 

combined with the substrate, and incubated again, followed by imaging and quantitation. (B) 381 

Representative images of a minimum signal control (complete AAV inhibition), a maximum signal 382 

control (no inhibition), and an ovine serum sample with ~50% signal inhibition. Scale bar = 0.5 383 

mm. 384 

 385 

Figure 2: Steps for determining percentage coloration using ImageJ software. (A) Open the 386 

image to be analyzed with ImageJ software. (B) Convert the image to 8-bit grayscale. (C) Open 387 

the threshold window. (D) Adjust the maximum threshold so all colored areas are covered, but 388 

the background area is not (this threshold should be consistent across an entire plate). (E) Select 389 

the 'Analyze' dropbox, click on 'Set measurements' and tick 'Area', 'Area fraction', 'Limit 390 

threshold' and 'Display label', and click on 'OK'. (F) Click on 'Measure' to measure the covered 391 

area. The % area indicates the proportion of the image that was colored. This can then be used 392 

with the control samples to determine the TI50 titer.  393 
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 394 

Figure 3: Optimization of viral dose and assessment of assay efficacy against an anti-AAV6 395 

monoclonal antibody (mAB). (A) The proportion of coloration (% of total area) for individual 396 

wells at different multiplicities of infection (MOI) and representative images (below) displaying 397 

the corresponding chromogenic reaction between the alkaline phosphatase (hPLAP) and 398 

NBT/BCIP for each viral dose (left). Percentage plate coverage is also shown in tabulated form 399 

(right). Each data point represents a technical replicate (n = 3 replicates per MOI). (B) A 400 

representation of the correlation between coloration and MOI is shown in Figure 3A. The red 401 

dotted line represents the highest concentration tested that did not affect the linear correlation 402 

between coloration and viral concentration.  (C) Neutralizing activity against AAV6 from an anti-403 

AAV6 monoclonal antibody at log10 dilutions. 50% inhibition of AAV6 transduction (TI50) is 404 

observed at a ~10 ng/mL concentration. n = 3 replicates per dilution. Data represent mean ± SEM. 405 

 406 

Figure 4:  Example of neutralizing antibody (Nab) assay results using ovine serum samples. (A)  407 

Adeno-Associated Virus (AAV) neutralizing serum samples were collected from 11 naïve sheep, 408 

measured in 2-fold serial dilutions ranging from 1/2 to 1/512. Colored lines represent samples 409 

with low and high neutralizing activity; grey lines represent the nine additional samples. The 410 

dotted line represents 50% transduction inhibition (TI50) and the corresponding TI50 titers for the 411 

low (blue) and high (green) representative samples. (B) AAV neutralizing activity of serum 412 

samples collected from five sheep before and after receiving a dose of AAV via direct cardiac 413 

injection. Neutralizing activity was assessed in 2-fold serial dilutions ranging from 1/2 to 1/32768. 414 

Each color represents serum from a different animal, filled lines represent pre-AAV 415 

administration and dotted lines represent post-AAV administration. n = 2-3 replicates per dilution 416 

for each sample. Data represent mean ± SEM. 417 

 418 

Table 1: Volumes of serum and diluent required to generate serial dilutions of serum in 419 

triplicate. 420 

 421 

Table 2: Example 96-well plate layout for assessing naïve serum samples in dilutions ranging 422 

from 1/2 to 1/512. Higher dilutions are incorporated into the assay if assessing a sample known 423 

to be positive for AAV NAbs (post-administration samples) or if a higher titer is required. MO (-424 

C): Media-only control. VO (+C): Virus and media only control. mAb: Monoclonal antibody against 425 

AAV (NAb positive control). 426 

 427 

Table 3: Impact of AAV exposure on neutralizing activity. Neutralizing activity for sheep was 428 

assessed before and after receiving a direct cardiac injection of a rAAV6 at varying doses. The 429 

dose received pre and post TI50 titers and fold change following administration are displayed. 430 

 431 

Supplementary Figure 1: Visual examples of different reasons for excluding sample wells. (A) 432 

The presence of contamination can be seen by clumps in the center. (B) High cell density. (C) 433 

Uneven lighting of well (left image), corresponding thresholding of the same well displaying 434 

excess coverage in the bottom right corner (right image). (D) Technical replicate images, the 435 

image on the left representing results with normal cell density, the image on the right reflecting 436 

results with low cell density. (E) Cells are unevenly distributed across a well. 437 
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 438 

Supplementary Figure 2: Simplified plasmid map displaying hPLAP insert. CMV: 439 

Cytomegalovirus promoter. hPLAP: human placental alkaline phosphatase. SV40: Simian virus 40 440 

polyadenylation signal. ITR: Inverted terminal repeat sequences. 441 

 442 

DISCUSSION: 443 

This report describes a colorimetric assay that assesses the extent of AAV neutralization in a given 444 

serum sample by evaluating a chromogenic reaction corresponding to the degree of in vitro viral 445 

transduction. The development of the protocol was based on the known chromogenic reaction 446 

between the enzyme alkaline phosphatase and NBT/BCIP, which has been widely utilized as a 447 

staining tool for the detection of protein targets in applications such as immunohistochemistry 448 

and as a reporter tool for evaluating viral transduction24,33-35. Its merit stems from its time and 449 

cost-effectiveness, accessibility, ease of setting up and performing while still demonstrating a 450 

high degree of efficacy. The rAAV6 employed in this assay (AAV-hPLAP) carries the reporter gene 451 

human placental alkaline phosphatase (hPLAP) and is driven by a cytomegalovirus (CMV) 452 

promoter34 (Supplementary Figure 2). NBT/BCIP is an hPLAP substrate that is initially 453 

dephosphorylated by alkaline phosphatase and sequentially undergoes oxidization to form a 454 

dimer, resulting in an insoluble product that is a vibrant purple color36.  455 

 456 

In selecting the optimal MOI for this assay, the aim was to establish a viral concentration that 457 

would sufficiently express the AAV reporter gene through virus-cell binding, and in conjunction 458 

with the NBT/BCIP substrate, provide coloration within a range that could be accurately 459 

measured. An MOI of 15,000 was selected, as it was the highest concentration tested that did 460 

not affect the linear correlation between coloration and viral concentration. Higher 461 

concentrations (50,000 and 1,50,000 MOI) caused the concentration-color response curve to 462 

plateau, indicating color saturation (Figure 3B). Assessment of viral MOIs between 0 and 15,000 463 

(n = 6) and their corresponding level of coloration resulted in r = 0.995 (P < 0.001), validating the 464 

sensitivity of the assay by establishing a very strong positive correlation between viral 465 

concentration and reporter-gene driven coloration. Given potential variability in factors such as 466 

cell culture conditions, laboratory technicians, techniques, and equipment, as well as variations 467 

in viral batches, it is recommended that any new user perform a preliminary trial assessment of 468 

the optimal MOI when establishing a NAb assay. 469 

 470 

The MOI chosen for a given NAb assay is a major contributing factor in the overall titer observed 471 

for a given serum sample. If an MOI of 5,000 instead of 15,000 had been selected, a 3-fold 472 

difference in titer value would be anticipated. This has historically been problematic in the field 473 

of AAV gene therapy, as different preclinical and clinical trials have implemented AAV NAb assays 474 

with MOI values ranging from less than 1,000 to as high 25,00037, meaning any kind of cross-475 

study comparison of NAb titers for a given AAV serotype is of little to no value. It has recently 476 

been suggested that reporting titers as neutralized AAV particles per μL of serum can provide 477 

more comparable values across different studies9,38. Numerous other factors may contribute to 478 

variation in titers between studies, such as the choice of the cell line, reporter gene, incubation 479 

times, and culture conditions. To facilitate the standardization of AAV NAb assays, both the titer 480 

values and neutralized AAV particles/μL of serum have been reported. 481 
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 482 

It is essential to include a serial dilution of a known NAb sample on every plate to act as both a 483 

positive control and a common sample between plates. This is important to identify any possible 484 

variability between separate runs. A neutralizing monoclonal antibody against the AAV of interest 485 

is an ideal positive control and standard, but a serum sample that is positive for NAbs is also 486 

acceptable.  The efficacy of the assay was validated by demonstrating that a monoclonal antibody 487 

specific to intact AAV6 particles (ADK6) can quantitatively inhibit transduction in a concentration-488 

dependent manner.  489 

 490 

Based on the manufacturer's material datasheet, the BCIP/NBT substrate system produces the 491 

insoluble blue-purple product within ~10 min and is very stable. However, it is noted that 492 

procedures may affect the length of incubation time. Based on prior reports, time frames of 1-24 493 

h have been used30,39. For this assay, incubation times must be consistent between runs. The time 494 

flexibility allows users to photograph wells either on day 3 of the protocol or the following day. 495 

 496 

Preclinical trials using large animal models provide a crucial stepping-stone between the 497 

laboratory and the clinic due to the physiological resemblance that animals such as sheep and 498 

pigs share with humans1,40,41. Historically, most candidate AAV gene therapies that have made it 499 

to clinical trials have undergone preliminary trials in large animals1. Multiple studies have 500 

demonstrated that both humans and a range of large animals, including sheep, pigs, dogs, 501 

rabbits, and non-human primates, can harbor neutralizing antibodies against AAV6 as well as 502 

many other AAV serotypes 42,43. This highlights the importance of preliminary screening for NAbs 503 

before trials in both large animal models and humans. NAb status of serum samples from sheep 504 

that had no previously known exposure to AAV was assessed, of which 10 of 11 displayed TI50 505 

titers <1/30 (<3 x 107 neutralized AAV particles/μL of serum). In contrast, one displayed a TI50 506 

titer of 1/80 (7.5 x 107 neutralized AAV particles/μL of serum). Five of the sheep went on to 507 

receive direct cardiac muscle injection of rAAV. Amongst all samples, administration of AAV 508 

dramatically changed the neutralizing activity, with fold change increases ranging from 125 to a 509 

>10,000 fold in TI50 titer values between pre and post AAV exposure (Table 3).  Of note, the lowest 510 

AAV6 dose administered (5 x 1012 vg) corresponded to the lowest post-AAV TI50 titer value (TI50 511 

titer 1/2000) and fold change increase (125 fold). In comparison, no clear evidence of pre-existing 512 

NAbs within the 11 naïve sheep was observed at levels that would prevent AAV transduction (all 513 

TI50 titer values <1/100). Data from the 5 sheep that received a direct AAV injection would suggest 514 

a cut-off for NAb positivity would be >1/1000 (based on pre-and post-AAV values). The stark 515 

difference between the pre-and post-NAb titer and the capacity to detect titers >1/32,000 516 

provides further validation of the efficacy and sensitivity of the assay. Establishing a cut-point at 517 

which a sample is deemed positive for neutralizing activity is an essential subsequent step when 518 

determining a threshold for NAb positive animals. This can be determined by assessing the 519 

variability in a group (~n ≥ 30) of naïve samples from a specific population of interest. This allows 520 

for establishing criteria to choose a statistically derived cut-point in which a sample is deemed 521 

positive for neutralizing activity. Alternatively, positive control samples from animals both pre-522 

and post-AAV administration, as shown in Figure 4B, can indicate the positive titer range for 523 

neutralizing activity. Recommendations regarding establishing cut-point thresholds and 524 
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validation and optimization of in vitro neutralizing assays have been described extensively in the 525 

literature44-47.   526 

 527 

The technique involves certain limitations. The use of the microscope camera to image wells is 528 

helpful because it provides very high-quality images that can accurately differentiate the degree 529 

of neutralization. However, microscopy can be labor intensive and may not be practical if 530 

processing many (>100) samples. A high-resolution flatbed or plate scanner may provide a more 531 

rapid approach to imaging the wells if the quality and lighting of images can be maintained. High 532 

MOI's have been reported to reduce assay detection sensitivity. It has been suggested that high 533 

AAV doses may evade neutralizing activity or that AAV transduction may occur in the presence 534 

of NAbs48-50. This assay uses a moderately high MOI (15,000); however, the sensitivity does not 535 

appear to be impeded as it can detect neutralizing activity at very high dilutions (>1:32,000) 536 

(Figure 4B). Lastly, as this assay uses a viral vector, appropriate approval by a governing body is 537 

generally required to use recombinant AAV; this will differ from country to country. 538 

 539 

In summary, this in vitro assay provides a rapid, cost-effective, easily accessible, and simple 540 

method to detect the presence of neutralizing antibodies against rAAV6. This assay can be 541 

adjusted and optimized to perform with different AAV serotypes with relative ease. The AAV6-542 

hPLAP vector can be provided for this assay upon request. 543 

 544 
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Dilution cascade  label Dilution
3 x sample (240 μL) + 10% buffer 

volume (24 μL)

Ratio of 

serum:media

Dilution 1 (D1) 1/2 264 μL serum 264 μL media 50:50

Dilution 2 (D2) 1/4 264 μL D1 + 264 μL media 25:75

Dilution 3 (D3) 1/8 264 μL D2 +264μL media 12.5:87.5

Dilution 4 (D4) 1/16 264 μL D3 +264 μL media 6.25:93.75

Dilution 5 (D5) 1/32 264 μL D4 +264 μL media 3.13:96.87

Dilution 6 (D6) 1/64 264 μL D5 +264 μL media 1.56:98.44

Dilution 7 (D7) 1/128 264 μL D5 +264 μL media 0.78:99.22

Dilution 8 (D8) 1/256 264 μL D5 +264 μL media 0.39:99.61

Dilution 9 (D9) 1/512 264 μL D7 + 264 μL media 0.2:99.8

Dilution 10 (D10) 1/2048 132 μL D8 + 396 μL media 0.05:99.95

Dilution 11 (D11) 1/8192 132 μL D9 + 396 μL media 0.01:99.99

Dilution 12 (D12) 1/32768 132 μL D10 + 396 μL media 0.003:99.997
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1 2 3 4 5 6 7 8

A 1/2 1/2 1/2 1/2 1/2 1/2 1/2 1/2

B 1/4 1/4 1/4 1/4 1/4 1/4 1/4 1/4

C 1/8 1/8 1/8 1/8 1/8 1/8 1/8 1/8

D 1/16 1/16 1/16 1/16 1/16 1/16 1/16 1/16

E 1/32 1/32 1/32 1/32 1/32 1/32 1/32 1/32

F 1/64 1/64 1/64 1/64 1/64 1/64 1/64 1/64

G 1/256 1/256 1/256 1/256 1/256 1/256 1/256 1/256

H 1/512 1/512 1/512 1/512 1/512 1/512 1/512 1/512

Serum sample #1 Serum sample #2 Serum sample #3
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9 10 11 12

1/2 50 ng MAb 50 ng MAb 50 ng MAb

1/4 5 ng MAb 5 ng MAb 5 ng MAb

1/8 0.5 ng MAb 0.5 ng MAb 0.5 ng MAb

1/16 MO (-C) MO (-C) MO (-C)

1/32 VO (+C) VO (+C) VO (+C)

1/64 Sample #1 1/512 Sample #1 1/512 Sample #1 1/512

1/256 Sample #2 1/512 Sample #2 1/512 Sample #2 1/512

1/512 Sample #3 1/512 Sample #3 1/512 Sample #3 1/512

Mono AB (mAB), controls and extra samplesSerum sample #3



Sheep ID Administration status Dose received (vg) NAb Titer (TI50)

Pre-AAV  1/5

Post –AAV 1/32000

Pre-AAV 1/80

Post –AAV 1/16000

Pre-AAV 1/16

Post –AAV 1/2000

Pre-AAV  1/4

Post –AAV >1/32000

Pre-AAV  1/8

Post –AAV 1/12000

1x10
13

1x1013

5x10
12

2x10
13

3x10
13

Sheep 1

Sheep 2

Sheep 3

Sheep 4

Sheep 5
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AAV neutralized / μL serum Fold change Pre vs.  Post

5.6x10
6

3x10
10

7.5x107

1.5X10
10

1.5x10
7

1.9x109

3.8x10
6

>3x10
10

7.5x10
6

2.3x10
10

6400

200

125

>10000

1700
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Editorial comments: 
Changes to be made by the Author(s): 

 

Responses to the editorial comments are shown in red. 

 

1. Please take this opportunity to thoroughly proofread the manuscript to ensure that there are 

no spelling or grammar issues. –Proof read for spelling and grammar.  

2. Please provide an email for each author. Email addresses not already included on the title 

page have now been added.  

3. Please revise the text to avoid the use of any personal pronouns (e.g., "we", "you", "our" 

etc.). Personal pronouns have been removed. 

4. Please ensure that all the abbreviations are defined at the first instance. All abbreviations 

have been checked and defined at first use. 

5. JoVE cannot publish manuscripts containing commercial language. This includes 

trademark symbols (™), registered symbols (®), and company names before an instrument or 

reagent. Please remove all commercial language from your manuscript and use generic terms 

instead. All commercial products should be sufficiently referenced in the Table of Materials. 

For example: Vacuette, Millipore, Agilent 141 Technologies –All trademark symbols and 

commercial products have been removed (except in the table of materials). 

6. Please ensure that all text in the protocol section is written in the imperative tense as if 

telling someone how to do the technique (e.g., “Do this,” “Ensure that,” etc.). The actions 

should be described in the imperative tense in complete sentences wherever possible. Avoid 

usage of phrases such as “could be,” “should be,” and “would be” throughout the Protocol. 

Any text that cannot be written in the imperative tense may be added as a “Note.” However, 

notes should be concise and used sparingly. Please include all safety procedures and use of 

hoods, etc. –Text is updated in the protocol to be in the imperative tense, and otherwise are 

added as a note. 

7. Please note that your protocol will be used to generate the script for the video and must 

contain everything that you would like shown in the video. Please add more details to your 

protocol steps. Please ensure you answer the “how” question, i.e., how is the step performed? 

Alternatively, add references to published material specifying how to perform the protocol 

action. Please add more specific details (e.g. button clicks for software actions, numerical 

values for settings, etc) to your protocol steps. There should be enough detail in each step to 

supplement the actions seen in the video so that viewers can easily replicate the protocol. –

More detail has been added to the protocol steps, describing how each step is performed or 

referencing published material.  

8. Please add more details to your protocol steps: 

Step 1.1: Please include the age/sex/strain of the animals used. Please mention how the serum 

samples from the animals were collected. Age and sex of sheep and method for collecting 

serum has been added. A citation will also suffice. Please convert centrifuge speeds to 

centrifugal force (x g) instead of revolutions per minute (rpm) RPM has been changed to (x 

g). 

Step 1.4: Please mention the pore size and the material of the filtering unit. Pore size and 

filtering material has been included. 

Step 3.3: Please mention what virus solution was used and what was the source of the 

solution. If obtained commercially, please include the details in the Table of Materials. –The 

concentration of the stock virus for our experiment has been added to the protocol (but this 

may differ from batch to batch). The source of the virus is in the table of materials and it is 

mentioned that it is available upon request in the protocol. 

Step 4.2: How was the aspiration done? Was a pipette used? –Details regarding aspiration 

Rebuttal Letter Click here to access/download;Rebuttal Letter;Editorial
comments_Nab assay_JOVE_16_11_21.docx
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have been added to the protocol. 

Step 5: Please also ensure that the button clicks for the software steps are bolded throughout. 

–Button clicks have been bolded. 

Step 5.1: Please provide the weblink for the source of ImageJ in the Table of materials. – The 

weblink for ImageJ is in the table of materials under the comments column. 

Step 6.2/7.1: Please include a citation for the equation used. –Citation is included for 

equations used unless the equation is a standard formula. 

9. Please include one line space between the protocol steps and highlight that identifies the 

essential steps of the protocol for the video, i.e., the steps that should be visualized to tell the 

most cohesive story of the Protocol. Remember that non-highlighted Protocol steps will 

remain in the manuscript, and therefore will still be available to the reader. Steps to include 

have now been highlighted. This could be reduced if too lengthy. 

10. Please ensure that the highlighted steps form a cohesive narrative with a logical flow from 

one highlighted step to the next and also is in-line with the Title of the manscript. Please 

highlight complete sentences (not parts of sentences). Please ensure that the highlighted part 

of the step includes at least one action that is written in imperative tense. However, the 

NOTEs cannot be filmed, so please do not highlight. –Steps are logical and include 

imperative text. 

11. Please submit each Figure individually in a high-resolution format to your Editorial 

manager account. Also please ensure that all the Figures are in correct orientation. Figures 

submitted as individual PNG. 

12. All Tables should be uploaded separately to your Editorial Manager account in a .xls or 

.xlsx file. –Uploaded tables as individual excel files. 

13. Please include a paragraph on the limitations of the method in the Discussion section. –A 

limitations paragraph has been incorporated into the discussion. 

14. Please do not abbreviate the journal names in the References. The reference list has been 

updated to include full journal name for all references. 
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Reviewers' comments: 

Responses to reviewer’s comments are shown in italics. 

 

Reviewer #1: 
Manuscript Summary: 

manuscript contains useful protocol for detecting neutralizing anti-AAV6 activity in 

biological samples. I had not major comments. 

We were pleased the reviewer thought our protocol was useful. 

 

Major Concerns: 

none 

 

Minor Concerns: 

As a relatively minor recommendation, consider clarifying what is meant by "colored area" 

when describing detection step. This can be done by stating that upon addition of substrate, 

colored product will deposit in the area around the cells expressing enzyme.  

This additional information has been added to page 7. 

- Also, in the abstract consider providing data supporting acceptable assay performance  

We agree this is a good point and have added data from sheep pre- and post-AAV which 

supports acceptable assay performance into the abstract. 

 

 

Reviewer #2:  
Manuscript Summary: 

The manuscript describe an interesting protocol for NAb levels assessment in vitro by using 

an AAV encoding an alkaline phosphatase (AP) reporter gene and its substrate NBT/BCIP. 

Determination of NAb has been a challenge for the field, and the lack of agreement between 

the centers regarding the multiples variables that can affect the current methods have made 

difficult to compare any available method or results. One of the major difficulties of the 

current methods is the need of specific instruments with high cost (no accessible for small or 

medium level centers). The protocol describe here relies in a free imaging software as ImageJ 

which clearly facilitates its implementation in any lab or center. 

We were pleased that the reviewer recognised that the protocol described is accessible to 

more labs/centres than many current methods. 

 

Major Concerns: 

my major concern is the necessity of an almost 'perfect' culture scenario and readout to avoid 

any misreading interpretation.  

We thank the reviewer for raising the point and appreciate the concern. While we think it is 

good practice to use optimal cultures we do not think a “perfect” culture scenario is 

essential given the significant shifts in the curves we identified in sheep pre- and post-AAV.   
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However, to avoid misinterpretation we have incorporated controls so that plates can be 

excluded if required e.g. if the positive and negative control did not work. 

Firstly, a number of controls including: i) virus only, ii) a neutralizing antibody positive 

sample, and iii) a no virus sample is included on every plate, and serial dilutions are 

generated for every sample.  

Secondly, the transduction inhibition readout is calculated using the virus only (maximum 

signal) and no virus samples (minimum signal) for every plate, accounting for between-plate 

variation. 

Thirdly, all samples are run in duplicate or triplicates and the mean value for each is 

determined accounting for variability between wells on a given plate. 

The text has been updated in section 3.2. 

 

Minor Concerns: 

none 

 

 

Reviewer #3:  
Manuscript Summary: 

In this study the authors managed to establish a protocol to measure Nab titer against AAV6 

carrying alkaline phosphatase (AP) as a reporter gene. The protocol based on applying a 

colorimetric assay which detects color changing after adding the substrate (NBT/BCIP). The 

authors carried on with an in vivo experiment to inject AAV6 in 11 sheep and measured 

pre/post injection Nab titer. 

 

Major Concerns: 

I have no major concerns. 

We were pleased the reviewer had no major concerns. 

 

Minor Concerns: 

In this protocol serum samples collected from sheep were used as test samples. It is not clear 

what was the rational for measuring Nab against AAV6.  

We have now added more information to provide rationale for using AAV6. 

Additional text added to the introduction is highlighted below in blue and page 3. 

 “the presence of pre-existing neutralizing antibodies (NAbs) against AAV vector capsids 

remains a hindrance to both preclinical research, and the efficacy of clinical trials. NAbs are 

present in both naïve human and animal populations and inhibit gene transduction following 

in vivo administration of an AAV vector1. AAV seropositivity is an exclusion criterion for 

most gene therapy trials and therefore preliminary screening for host immunity is crucial in 

both the laboratory and the clinic. Establishing an assay that can detect the presence of NAbs 

against AAV is an essential step in the pipeline of any AAV gene therapy-based research 

project. This report focuses on AAV6 which has been of interest to researchers due to its 
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efficient and selective transduction in striated muscle (heart and skeletal muscle)1,10-12. Gene 

therapy is considered a promising strategy for targeting the heart because it is difficult to 

specifically target the heart without invasive open-heart procedures.  

 

In the introduction (or discussion) part, the authors may include more details regarding the technical 

advantages of colorimetric assay comparing to other assays, is it more sensitive, reliable? In 

addition, they may briefly compare their approach with similar approaches, e.g. PMID: 27910044.  

We agree that further details are helpful for the reader, and we have inserted the reference 

recommended, as well as some additional references. The following text has been added to 

the Introduction (page 3). 

“NAb assays that use a luminescence based reporter gene have the additional requirement of 

costly substrate kits, a luminometer and corresponding software for analysis21. This 

colorimetric assay has the advantage of only requiring a light microscope and a very cheap 

substrate. Reporting of the sensitivity of colorimetric verses luminescent assays has yielded 

conflicting results. One study suggested luminescence based ELISA assays display greater 

sensitivity and comparable reproducibility to colorimetric assays22, whilst another study 

found colorimetric based ELISA assays to confer greater sensitivity23” 

Please clarify that you collected blood from the sheep in 8 ml Vacuette tubes in step 1.1 of initial 

preparation(to obtain serum after centrifugation)?  

This has been clarified in 1.1. However, to meet editorial requirements, it was not possible to 

include “Vacuette” because commercial names cannot be included. But this has been 

included within the table of materials. 

 

At day 1 step 2.3 the authors didn't mention the plate's type they used (clear, white or black plate) 

as the same plate is used later for imaging.  

This detail has now been provided. 

 

At day 3 step 4.7: What does incubation time (2-24h) depend on? Is the time point the incubation is 

ended based on the color development?  if yes, does the time also vary based on the antibodies 

concentration?  

Based on the manufacturer’s material data sheet, the BCIP/NBT substrate system produces 

the insoluble blue-purple product within 10 min, and is very stable. However, it is noted that 

procedures may affect the length of incubation time. Based on prior reports, time frames of 1-

24h have been used35,36. For this assay, it is important that incubation times are consistent 

between runs. The time flexibility, allows users to photograph wells either on day 3 or the 

following day. We have added more detail on page 12. 

 

At day 3 step 4.8 the authors used an imaging method to quantify Nab titer. Did authors consider 

measuring color emission from cell lysate and then normalize it to the number of cells to avoid a cell 

overlay effect?  
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We agree this method may also work but was not one we considered or tested because we 

observed a very strong positive correlation between virus MOI and % colouration. We have 

not tested whether the reaction will be as consistent/effective in lysate verse adhered cells. 

We are not aware of similar colorimetric cell based assays quantifying results in this way but 

are happy to incorporate references and discussion if the reviewer is aware of such 

references. 

 



Contamination High cell density Lighting imbalance

Technical replicates: Left Image: Normal, Right image: Low cell density Uneven cell distribution
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